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Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the 
1LSb INL Dual DAC Evaluation Board. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Website

• Customer Support

• Document Revision History

DOCUMENT LAYOUT
This document describes how to use the 1LSb INL Dual DAC Evaluation Board to 
demonstrate the performance of the MCP47CXDX2/MCP48CXDX2 DAC family. The 
manual layout is as follows:

• Chapter 1. “Product Overview” – Provides quick, step-by-step information on 
setting up the 1LSb INL Dual DAC Evaluation Board.

• Chapter 2. “Installation and Operation” – Important information about the 1LSb 
INL Dual DAC Evaluation Board.

• Chapter 3. “Code” – Refer to the board’s web page for complete Code.

• Appendix A. “Schematics” – Refer to the board’s web page for the complete 
Schematics.

• Appendix B. “Bill of Materials (BOM)” – Refer to the board’s web page for the 
complete Bill of Materials.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2023 Microchip Technology Inc. and its subsidiaries  DS50003526A-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, Italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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Preface
RECOMMENDED READING

This user’s guide describes how to use the 1LSb INL Dual DAC Evaluation Board. 
Other useful documents are listed below. The following Microchip documents are 
available and recommended as supplemental reference resources.

• MCP47CXDX1/2 Data Sheet – “8/10/12-Bit Digital-to-Analog Converters, 
1 LSb INL, Single/Dual Voltage Output with I2C Interface” (DS20006666)

• MCP48CXDX1/2 Data Sheet – “8/10/12-Bit Digital-to-Analog Converters, 
1 LSb INL, Single/Dual Voltage Outputs with SPI Interface” (DS20006556)

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website is 
used as a means to make files and information easily available to customers. Accessible 
by using your favorite Internet browser, the website contains the following information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Embedded System Engineer (ESE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the website at: 
https://www.microchip.com/support.

DOCUMENT REVISION HISTORY

Revision A (May 2023)

• Initial release of this document.
 2023 Microchip Technology Inc. and its subsidiaries  DS50003526A-page 7
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Chapter 1.  Product Overview
1.1 INTRODUCTION

This chapter provides an overview of the 1LSb INL Dual DAC Evaluation Board.

The MCP47CXDX2/MCP48CXDX2 is a 12-bit, 1 LSb DAC. The devices offer two 
memory options: MCP47CVDX2/MCP48CVDX2 devices have volatile memory, while 
the MCP47CMDX2/MCP48CMDX2 have 32-times programmable nonvolatile memory 
(MTP).The devices operate from a single-supply voltage of 2.7V to 5.5V for full 
specified operation and 1.8V to 5.5V for digital operation.

The devices populated on the 1LSb INL Dual DAC Evaluation Board are the nonvolatile 
I2C DAC (MCP47CMD22) and the nonvolatile SPI DAC (MCP48CMD22).

1.2 1LSB INL DUAL DAC EVALUATION BOARD OVERVIEW

The Microchip 1LSb INL Dual DAC Evaluation Board is used to evaluate the 
MCP47CXDX2 and MCP48CXDX2 DAC families. Users can now easily evaluate 
features of the MCP47CXDX2/MCP48CXDX2 devices by connecting the evaluation 
board to any of the Microchip Curiosity microcontroller development boards. The 1LSb 
INL Dual DAC Evaluation Board supports the mikroBUS™ click board™ and can be 
mounted on any of the mikroBUS supported MCU boards. The 1LSb INL Dual DAC 
Evaluation Board supports both the I2C family (MCP47CXDX2) of devices and the SPI 
DAC family (MCP48CXDX2).

Figure 1-1 shows the top view of the 1LSb INL Dual DAC Evaluation Board. Figure 1-2 
shows the bottom view of the board.
 2023 Microchip Technology Inc. and its subsidiaries  DS50003526A-page 9
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FIGURE 1-1: 1LSb INL Dual DAC Evaluation Board (Top View).    

FIGURE 1-2: 1LSb INL Dual DAC Evaluation Board (Bottom View).
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Product Overview
Figure 1-3 shows the 1LSb INL Dual DAC Evaluation Board mounted on the Curiosity 
microcontroller board, using the mikroBUS™ connector.
   

FIGURE 1-3:      1LSb INL Dual DAC Evaluation Board Mounted on the 
mikrobus™ Click Board™ of the Curiosity HPC Development Board (DM164136).

1.3 1LSB INL DUAL DAC EVALUATION BOARD FEATURES

The 1LSb INL Dual DAC Evaluation Board is a fully-assembled board. The board can 
be mounted on any of the Microchip MCU boards that feature the mikroBUS connector 
(MCU board not included with this board). The MCU board can be programmed to 
evaluate and demonstrate the operating performance of the MCP47CXDX2 and 
MCP48CXDX2 DAC family.

The product page provides the code required to communicate with the MCP47CXDX2 
and MCP48CXDX2 DAC family and is intended for use with the Microchip Curiosity 
HPC Development Board (DM164136).

The 1LSb INL Dual DAC Evaluation Board has the following features:

• Supports both SPI and I2C devices

• Supports 5V and 3.3V options

• mikroBUS support makes it easy to evaluate with any of the Microchip MCU 
boards

• External voltage reference option for the DAC

• MCP1501-25 on-board voltage reference for external VREF option.

1.4 1LSB INL DUAL DAC EVALUATION BOARD KIT CONTENTS

The 1LSb INL Dual DAC Evaluation Board includes the following items:

• 1LSb INL Dual DAC Evaluation Board (EV17X13A).
 2023 Microchip Technology Inc. and its subsidiaries  DS50003526A-page 11
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Chapter 2.  Installation and Operation
2.1 GETTING STARTED

The 1LSb INL Dual DAC Evaluation Board can be used by following the three steps 
listed below.

 Step 1. Connect the 1LSb INL Dual DAC Evaluation Board to the top-right mikroBUS 
header on the Curiosity HPC Board, as shown in Figure 1-3.

 Step 2. Compile the code provided on the product page and program the on-board 
PIC18F47Q10 microcontroller. Steps to compile and program are explained 
below.

2a) Open MPLAB IDE, go to the File menu and select “New Project...”.

FIGURE 2-1: Start a New Project in the MPLAB IDE.

    

Note: The code provided on the product page enables use of the 1LSb INL Dual 
DAC Evaluation Board with the Curiosity HPC Development Board 
(DM164136). Once the Curiosity HPC board has been programmed with 
this code, the DAC’s output can be monitored on the VOUT pin using an 
oscilloscope.

Note: Download and install MPLAB® IDE and XC18 compiler from
www.microchip.com.
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2b) Select “Standalone Project” and click Next.
  

FIGURE 2-2: Select Standalone Project.

2c) Select PIC18F47Q10 as the device and click Next.
 

FIGURE 2-3: Select the Device.

2d) From the “Select Tool” menu, choose “Curiosity/Starter Kits (PKOB4)” and click 
Next.

 

FIGURE 2-4: Select the Tool.
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Installation and Operation
2e) Select XC8 as the Compiler and click Next.
 

FIGURE 2-5: Select the Compiler.

2f) Name the project, provide the project location and click Finish.

2g) From the File menu, select “New File...”.
  

FIGURE 2-6: New File.
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2h) From Categories, select “C” and, from File Types, select “C Source File” and click 
Next.

FIGURE 2-7: New File.

2i) Name the file (“DAC_SAMPLE” in the example shown in Figure j) and click 
Finish.

 

FIGURE 2-8: Name the File.

2j) From the file, right click Source File and select “Add Existing Item...”.
 

FIGURE 2-9: Add a Source File.
DS50003526A-page 16   2023 Microchip Technology Inc. and its subsidiaries



Installation and Operation
2k) Navigate to the project folder, then select the DAC_SAMPLE.c file and click the 
Select button.

 

FIGURE 2-10: Add a Source File.

2l) This will add the code contained within the DAC_SAMPLE.c file to the source 
code, as shown in Figure 2-11.

FIGURE 2-11: Add a Source File.

2m)Copy and paste the code to the DAC_SAMPLE.c file (make sure the code and 
comments are copied correctly). Connect the micro-USB cable to the micro-USB 
header on the left side of the Curiosity HPC Board using a micro-USB cable to 
provide power to the board. Press the icon shown in Figure 2-12 to compile and 
program the code.

FIGURE 2-12: Compile and Program the Code.

 Step 3. The LEDs on the Curiosity HPC Board will blink based on which code is 
running, and the user can monitor the DAC’s output using the VOUT pin (see 
Figure 2-13 and Figure 2-14).
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FIGURE 2-13: The LEDs, Switches and the Analog Potentiometer of the 
Curiosity HPC Board Used for the 1LSb INL Dual DAC Evaluation Board Demo.
 

FIGURE 2-14: 1LSb INL Dual DAC Evaluation Board SPI and I2C Output 
Waveform Monitoring.

LEDs D2 to D5

S1 Switch S2 SwitchAnalog Potentiometer

Monitor the output of the SPI 
DAC here using an 
oscilloscope.

Monitor the output of the I2C 
DAC here using an 
oscilloscope.

Connect a jumper between 
the VDD and 3.3V pins to 
power the board.
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2.2 SPI DEMO

Once the Curiosity board is programmed and running, LED D4 will blink, while the other 
LEDs will remain off. This indicates that the SPI DAC is working and the output can be 
monitored on CH0 of the SPI output. When LED D4 is blinking, Channel 0 will output a 
sine wave as shown in Figure 2-15.

FIGURE 2-15: SPI Output Sine Wave (LED D4 Blinking, LEDs D2, D3 and D5 
OFF, Channel 1 - SPI, Channel 2 - I2C).

The frequency of the sine wave can be modified by rotating the potentiometer on the 
Curiosity board, as shown in Figure 2-16. Rotating the potentiometer will also change 
the blink rate of LED D4.

FIGURE 2-16: SPI Output Sine Wave with Varying Frequency using the 
Potentiometer (LED D4 Blinking, LEDs D2, D3 and D5 OFF, Channel 1 - SPI, Channel 
2 - I2C).
 2023 Microchip Technology Inc. and its subsidiaries  DS50003526A-page 19
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When the S1 switch is pressed, the SPI output waveform will be a saw-tooth shape, as 
shown in Figure 2-17. LED D5 will blink, while LEDs D2, D3 and D4 will be off. This 
indicates SPI DAC is working and the output can be monitored on CH0 of the SPI 
output. The frequency of the waveform can be modified using the potentiometer on the 
curiosity board (see Figure 2-18).
 

FIGURE 2-17: SPI Output Saw-Tooth Waveform (S1 Switch Pressed, LED D5 
Blinking, LEDs D2, D3 and D4 OFF, Channel 1 - SPI, Channel 2 - I2C).

FIGURE 2-18: I2C Output Saw-Tooth Wave with Varying Frequency using the 
Potentiometer (S1 Switch Pressed, LED D5 blinking, LEDs D2, D3 and D4 OFF, 
Channel 1 - SPI, Channel 2 - I2C).
DS50003526A-page 20   2023 Microchip Technology Inc. and its subsidiaries
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2.3 I2C DEMO

Once the Curiosity board is programmed and running, press the S2 switch. The D2 
LED will blink while all the other LEDs will remain off. This indicates that the I2C DAC 
is working and the output can be monitored on CH0 of the I2C DAC output. When LED 
D2 is blinking, the DAC’s Channel 0 will output a sine wave as shown in Figure 2-19. 
The frequency of the sine wave can be varied using the analog potentiometer.
 

FIGURE 2-19: I2C Output Sine Wave (LED D2 blinking, LEDs D3, D4 and D5 
OFF, Channel 1 - SPI, Channel 2 - I2C).

When the S2 switch is pressed, the I2C output waveform will be saw-tooth shaped. The 
D3 LED will blink while all the other LEDs will remain off. This indicates that the I2C 
DAC is working, and the output can be monitored on Channel 0 of the I2C DAC output. 
CH0 will output a saw-tooth waveform as shown in Figure 2-20. The frequency of the 
waveform can be modified using the potentiometer on the Curiosity board.
  

FIGURE 2-20: I2C Output Saw-Tooth Waveform (LED D3 blinking, LEDs D2, D4 
and D5 OFF, Channel 1 - SPI, Channel 2 - I2C).
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Figure 2-21 shows a flow-chart for the DAC demo.

FIGURE 2-21: Flowchart for the User Demo.

Power up the board and program the 
PIC18F47Q10

LED D4 Blinking (LEDs D2, D3 and D5 Off)
Sine wave output at SPI Channel 0

Frequency varied by using potentiometer
Status = SPI Sine

If S1 or S2 
pressed

If S1 pressed If S2 pressed

If Status = 
SPI Sine

If Status = 
I2C Sine

LED D5 Blinking
(LEDs D2, D3 and D4 Off)
SPI Saw-Tooth Waveform
Status = SPI Saw-Tooth

LED D4 Blinking
(LEDs D2, D3 and D5 Off)

SPI Sine Wave
Status = SPI Sine

LED D3 Blinking
(LEDs D2, D4 and D5 Off)
I2C Saw-Tooth Waveform
Status = I2C Saw-Tooth

LED D2 Blinking
(LEDs D3, D4 and D5 Off)

I2C Sine Wave
Status = I2C Sine

Yes

Yes Yes

No No

No
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Chapter 3.  Code
3.1 CODE

Program the PIC18F47Q10 on the Curiosity board with the code provided 
“DAC_SAMPLE.C” (https://www.microchip.com/en-us/product/MCP48CMD22) on the 
product page, in order to enable use of the connected 1LSb INL Dual DAC Evaluation 
Board. This will allow for monitoring and testing the DAC. 
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Appendix A. Schematics
A.1 INTRODUCTION

This appendix contains the following schematics and layouts for the 1LSb INL Dual 
DAC Evaluation Board - EV17X13A:

• Board – Schematics

• Board – Top Assembly Drawing

• Board – Bottom Assembly Drawing
 2023 Microchip Technology Inc. and its subsidiaries  DS50003526A-page 25
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Schematics
A.3 BOARD – TOP ASSEMBLY DRAWING

A.4 BOARD – BOTTOM ASSEMBLY DRAWING
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Appendix B. Bill of Materials (BOM)
TABLE B-1: BILL OF MATERIALS (BOM)

Qty. Reference Description Manufacturer Part Number

1 C1 Capacitor, tantalum, 10 μF, 16V, 10%, 3Ω, 
SMD A

KEMET B45196H3106K109

1 C2 Capacitor, ceramic, 2.2 μF, 16V, 10%, X5R, 
SMD, 0603

TDK Corporation C1608X5R1C225K

2 C3, C4 Capacitor, ceramic, 0.1 μF, 25V, 10%, X7R, 
SMD, 0603

Würth Elektronik 885012206071

1 J1 Connector, header-2.54, male, 1x3, gold, 
5.84MH, through hole, vertical

FCI 68000-103HLF

0 J2, J3 Connector, header-2.54, male, 1x1, gold, 
5.84MH, through hole, vertical – Do Not 
Populate

Samtec, Inc. TSW-101-07-S-S

1 J4 Connector, header-2.54, male, 2x2, Gold, 
5.84MH, through hole, vertical

Samtec, Inc. HTSW-102-07-G-D

1 J5 Connector, header-2.54, male, 2x4, gold, 
5.84MH TH VERT

Samtec, Inc. TSW-104-08-L-D

2 J6, J7 Connector, header-2.54, male, 1x8, gold, 
5.84MH, through hole

FCI 68001-108HLF

1 JP Mechanical, hardware, jumper, 2.54 mm, 
1x2 handle, gold – mechanical part

TE Connectivity, Ltd. 881545-2

1 LABEL Label, PCBA, 6x6 mm, Datamatrix ACT Logimark AS 505462

1 PCB1 Printed Circuit Board – 1LSb INL Dual DAC 
Evaluation Board

Microchip 
Technology Inc.

04-11739-R1

1 R1 Resistor, TKF, 51R, 5%, 1/10W, surface 
mount, 0603

Panasonic® – ECG ERJ-3GEYJ510V

2 R2, R3 Resistor, TKF, 2.2 kΩ, 5%, 1/10W, surface 
mount, 0603

Panasonic – ECG ERJ-3GEYJ222V

0 R4, R5, R10, 
R11

Resistor, TKF, 0R, 1/10W, surface mount,  
0603 – Do Not Populate

Panasonic – ECG ERJ-3GSY0R00V

2 R6, R7 Resistor, TKF, 100 kΩ, 5%, 1/10W, surface 
mount, 0603

Panasonic – ECG ERJ-3GEYJ104V

2 R8, R9 Resistor, TKF, 0R, 1/10W, surface mount, 
0603

Panasonic – ECG ERJ-3GSY0R00V

1 U1 Microchip, Analog, DAC, 2-Channel, 12-bit, 
MCP47CMD22T-E/MF, DFN-10

Microchip 
Technology Inc.

MCP47CMD22T-E/MF

1 U2 Microchip, Analog, DAC, 2-Channel, 12-bit, 
MCP48CMD22T-E/UN, MSOP-10

Microchip 
Technology Inc.

MCP48CMD22T-E/UN

1 U3 Microchip, Analog, VREF, 2.50V, 
MCP1501T-25E/CHY, SOT-23-6

Microchip 
Technology Inc.

MCP1501T-25E/CHY
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